HIGH PERFORMANCE USB AUDIO INTERFACE

USER MANUAL v1.1
connect with us.
facebook.com/audient
twitter.com/audientworld
youtube.com/audienthampshire

.audient.com

www.audient.com

WELCOME & THANK YOU

CONTENTS

Thank you for purchasing
this Audient product!

Box Contents				1
iD14 Overview				2
Safety Information				3
Declaration of Conformities		
5
Installation:					6

iD14 delivers the audio performance of
a large format console in a compact and
elegant desktop package.
iD14 provides a pair of world-class Audient
console mic pres, class leading Burr-Brown
converter technology, console style monitor
control, JFET D.I and the revolutionary
ScrollControl .
With its versatile feature set and intuitive
layout, iD14 will become the hub of your
studio in no time.

Features include:
•
•

2-in, 4-out high performance 			
Burr-Brown AD/DA converters
2 x Class-A Audient Console Mic
Preamplifiers & 1 x discrete JFET
instrument input.

•

Independant Class-AB Headphones
Output

•

Full Monitor Control Functionality
(software controlled)

•

iD ScrollControl Mode

•

ADAT Input for Expandibility

•

USB2.0 class compliant connectivity 		
with integrated Low Lateny DSP mixer

Installation on Mac 			
Installation on Windows		
iD App & Firmware Update		

Introduction

23

Digital Input Formats		
23
		
Clock Source & Lock		
23
		Talkback Assign		23
		
Mono Monitoring Modes
23
		Output Routing
24

6
8

Setting Up & Using Talkback		

25

Save & Load Mixer Presets		
Keyboard Shortcuts			

26

10

Hardware Features:			11
Microphone & Line Inputs		
12
Instrument Input			13
Digital Inputs				13
Loudspeaker Outputs			14
Headphone Outputs			
14
Monitor Control			15
Metering				16
Kensington Lock			16

iD Mixer Application:			

System Panel - Settings Module

17

Input Channel Types			
18
Channel Naming Tape		
18
Channel Strip Features		
19
Stereo Linking				19
Master Section Features		
20
Channel Views			21
Volume Control			21
Programming the iD Button		
22
		

27

Operation with Pro Tools			
Operation with Logic Pro			
Operation with Cubase / Nuendo
Operation with Ableton Live		

28
29
31
33

Troubleshooting & FAQ			
34
Specifications				37
Dimensions					38
Warranty & Contact			
39
Service					40
Glossary					41

Contents

BOX CONTENTS

ID14 OVERVIEW

In your iD14 packaging you should find the
following items:
•
•
•
•

Channel 1 Gain Channel 2 Gain
0 - 56 dB
0 - 56 dB

iD14
12VDC PSU with regional adapters
USB Type A-to-B Cable
Quick Start Guide

Main
Meters

Encoder

Encoder Mode
Buttons
48V Phantom
Power

Please visit:
www.audient.com/products/iD14
to download the latest iD software
(mixer application and drivers), supporting
documentation (including this manual)
and brochures for our product range.

Headphone
Volume Select

USB Status
LED

Speaker
Volume
Select

Programmable
iD Button

The 12VDC power supply comes with
interchangeable UK, EU, US and Australian
socket adapters and will work across a broad
range of line voltages making iD14 globally
portable.
We hope that you enjoy using iD14!
12VDC
Power

USB

Instrument D.I

1

Digital
Input

Loudspeaker
Output

Mic / Line
Inputs

Headphone
Out
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SAFETY INFORMATION

SAFETY INFORMATION

Important Safety Instructions

Important Safety Instructions

Please read all of these instructions and save them for later reference before connecting
the DC power adapter to the mains and powering up iD14.

1.
2.
3.
4.
5.
6.
7.

To prevent electrical shock and fire hazard follow all instructions on the 12VDC power supply.
iD14 itself does not operate with any high voltage mains supply inside the unit but appropriate
safety measures should still be adhered to regarding the AC/DC supply.
In the event of a power supply failure do not open the 12VDC supply. Please contact Audient
support so that a suitable replacement can be recommended or purchased.

8.

www.audient.com/support
iD14 utilises an external switch-mode power supply that is very quiet and rated at 1.25A. This
switch-mode design will accept any A.C line voltage from 90v to 264v @ 47-63Hz. Therefore
the unit will work anywhere in the world but please ensure your A.C mains line voltage is within
this specification.
Consult a qualified technician if you suspect difficulties. Do not attempt to tamper with the
power supply or mains voltages - HAZARDOUS TO HEALTH. Ensure that the appropriate
international pin adapter is fitted to the power supply before insertion into the mains socket.

! WARNING !

9.
10.
11.
12.

13.

TO REDUCE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPARATUS TO
RAIN OR MOISTURE.

Read these instructions
Keep these instructions
Heed all warnings
Follow all instructions
Do not use this equipment near water
Clean only with dry cloth
Do not install near any heat sources such as radiators, heat registers, stoves, or other
equipment (including amplifiers) that produce heat
Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized
plug has two blades with one wider than the other. A grounding type plug has two
blades and a third grounding prong. The wide blade or the third prong are provided for
your safety. If the provided plug does not fit into your outlet, consult an electrician for
replacement of the obsolete outlet
Protect power cords from being walked on or pinched particularly at plugs,
convenience receptacles, and the point where they exit from the equipment
Only use attachments/accessories specified by the manufacturer
Unplug this equipment during lightning storms or when unused for long periods of time
Refer all servicing to qualified service personnel. Servicing is required when the
equipment has been damaged in any way, such as power supply cord or plug is
damaged, liquid has been spilled or objects have fallen into the equipment, the
equipment has been exposed to rain or moisture, does not operate normally,
or has been dropped
For products that are a mains powered device: The equipment shall not be exposed
to dripping or splashing and no objects filled with liquids (such as vases) shall be
placed on the equipment

NO USER SERVICEABLE PARTS INSIDE.
PLEASE REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.
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DECLARATION OF CONFORMITIES

MAC OSX INSTALLATION

FCC Part 15B

System Requirements

This apparatus has been tested and found to comply with the limits of a class-A digital device,
pursuant to Part 15B of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. If this equipment
does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:

•
•

OSX: 10.8.5 (Mountain Lion) or later
Mac: Intel CPU, 1GB RAM Minimum

1. Download the Latest iD Software
Head to our website for the latest version of
our iD Mixer:
www.audient.com/products/downloads/iD14

1.
2.
3.
		
4.

Re-orient or relocate the receiving antenna
Increase the separation between the equipment and receiver
Connect the equipment into an outlet on a different circuit from that
to which the receiver is connected
Consult the dealer or an experienced radio/TV technician for help

		
		
		

We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK,
01256 381944, declare under our sole responsibility that the product iD14
complies with Part 15 of FCC Rules.

		

Operation is subject to the following two conditions:

		
1.
		
2.
			

Drag the downloaded app
application folder to install it.

into

your

2. Connect iD14
Using the USB cable provided, connect
iD14 to your computer’s USB port.
Optionally connect the 12VDC power
adapter if you require Phantom Power.

This device may not cause harmful interference,
This device must accept any interference received,
including interference that may cause undesired operation

		
		
		

We, Audient Ltd, declare that the product, the iD14, to which this declaration
relates, is in material conformity with the appropriate CE standards and directives
for an audio product designed for consumer use.

		
		
		
		

Audient Ltd has conformed where applicable, to the European Union’s Directive 			
2002/95/EC on Restrictions of Hazardous Substances (RoHS) as well as the
following sections of California law which refer to RoHS, namely sections 25214.10, 		
25214.10.2, and 58012, Health and Safety Code; Section 42475.2, Public Resources
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MAC OSX INSTALLATION

WINDOWS INSTALLATION

3. Status LED

Windows System Requirements:

Once connected to your computer and
powered on, the green status LED on iD14
will illuminate.

•
•
•

Windows 7 or later (32 and 64 bit)
Intel Core 2 @ 1.6 GHz, or AMD 		
equivalent
1 GB RAM Minimum

1. Download the latest iD14 Software
If at any time the status LED turns off
during normal operation please check all
connections and if further problems develop
please contact Audient support.

Head to our website for the latest version of
our iD Windows Installer:
It’s also worth checking Audio MIDI Setup
(found in Mac HD > Applications > Utilities).

4. Double Checking Connectivity

www.audient.com/products/downloads/iD14

2. Connect iD14

Window > Show Audio Window
To ensure iD14 has been detected by your
computer and correct clocking sources are
set-up, navigate to:
Macintosh HD > Applications >
System Preferences

Here you should see iD14 report with 10
inputs and 4 outputs. Clock source is
configured in the iD app. See page 23 for
more details.

Using the USB cable provided, connect
iD14 to your computer’s USB port.
Optionally connect the 12VDC power
adapter if you require Phantom Power.

3. Run iD Mixer Setup

Check that iD14 is set as your i/o device.
It’s recommended to disable system sounds.

Double click on the installer to run the
iD mixer setup and follow the onscreen
instructions.

4. Reboot PC
Reboot your PC to make sure that all the
drivers have been applied.

7
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WINDOWS INSTALLATION

MIXER APP & FIRMWARE UPDATE

4. Check Connectivity

Launch the iD Mixer Application

Firmware Update

Launch the iD14 mixer application
by finding it in the following folder:

When there is a firmware update, you can
select ‘From audient.com’ to download the
latest version automatically (or select ‘From
file’ to install a local firmware file).

The status LED will become solidly lit as soon
as iD14 has achieved stable communication
and should remain solidly lit during operation
of the unit until power down.
To double check the connection, go to PC
sound settings by following:
PC Settings > Control Panel > Hardware
and Sound > Sound
Here you can see whether iD14 is
visible to the PC and you can make it
the computers default sound device by
pressing ‘Set Default’.

iD Icon
Once installed, the iD icon can be found in
the Windows system tray (it may be in the
hidden icons area):
•
•

Double-click to open iD14 mixer window
when iD14 is connected
Right-click to quit or change sample
rate, buffer size and latency settings

Macintosh HD > Applications > iD
Start > All Programs > Audient > iD
Latency refers to how often iD14 sends
and receives its data, for example it is not
possible to have a high latency setting and
a low buffer size because the buffer would
fill up with samples before iD14 has the
chance to send them.
For mixing, latency of ‘Standard’ and buffer
size of 256 should be perfect. For tracking,
experiement with lower latency and buffer
size values. How powerful your computer
is, and how processor hungry your project
is, will affect how low you can get the
latency and buffer size settings before you
get audio instability.
Latency Modes:
		Minimum 1ms
		Low		2ms
		Standard 4 ms
		Relaxed
8ms
		Safe		16ms
		Extra Safe 32ms

For more information on the mixer
application feature set, please refer to
page 17 of this manual onwards.

Check for Firmware Updates
If your computer is connected to the internet,
the iD app will check for firmware updates
whenever a unit is connected. If there is a
firmware update available then the iD app
will notify you.

The latest version number will be retrieved
from our servers and will be displayed (as
shown above). Press next to continue with
the firmware update. Press ‘update’ to
install it and once complete reboot iD14 to
apply it.

You can manual check for updates by going
to the Help menu and selecting ‘Check for
Updates’. It will notify you if you’re on the
latest version of firmware.
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HARDWARE FEATURES

HARDWARE FEATURES
Microphone Preamplifiers
& Line Inputs

HARDWARE

iD14 features two classic Audient
microphone preamplifiers. These preamps
are based on designs from Audient’s classic
consoles and are the same that are used
across our entire product range.
The design features discrete Class-A
circuitry providing exceedingly low distortion
and noise performance. From a sonic point
of view, iD14 is fast, open and detailed.
The microphone preamplifiers feature:
NeutrikTM XLR/TRS Jack combi-connectors
provide microphone and line inputs. The line
inputs are padded through the microphone
preamplfiiers.

•
•
•

NOTE
Due to power restrictions over USB and the
requirements of the high quality mic pres and
converters, phantom power is only enabled
when using the 12V power supply.

11

•

56 dB of clean gain
48v (±4V) phantom power rated at
10mA/channel
> 2.8kΩ input impedance which provides
a punchy tone from any microphone
transducer type
Extra features such as a +10dB boost
and polarity reverse can be		
accessed via the iD App (See page 19).
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HARDWARE FEATURES

HARDWARE FEATURES

Instrument Input

Digital Inputs

Speaker Outputs

Headphone Output

iD14 employs a discrete class-A JFET
instrument (D.I) input on channel one which
is easily accessible on the front of the unit.

iD14 features an optical input
connection. This can be set to operate as
stereo optical S/PDIF or 8-channel ADAT
(SMUX) via the System Panel in the iD mixer
application. Both formats will operate at up
to 96kHz sample rate.

iD14 has stereo speaker outputs on the
back panel in the form of balanced TRS jack
connectors. The outputs are impedance
balanced using the same topology as our
flagship console, the ASP8024.

iD14 features a high current headphone
amplifier which is fed by it’s own seperate DAC
and can be accessed from the headphone
jack on the front of the unit.

The JFET circuitry adds a tiny bit of colour
and distortion to the signal, making it sound
great on guitars and basses.
Plugging in a TS (tip-sleeve unbalanced)
jack will override the mic signal and turn
channel one into a fully fledged, fantastic
sounding instrument input with access to the
polarity reverse (useful for phase alignment
between a mic and D.I) and the +10dB boost
for quiet inputs.

The outputs are fed from high quality
Burr-Brown DACs (Digital to Analogue
Convertors) sending clean, linear audio to
your speakers, perfect for critical listening.

Running in S/PDIF mode, the optical input
provides the option to integrate an external
mic pre, allowing 2 channels of audio up to
96KHz.
Running in ADAT mode, the optical input
provides a great way to expand to 10 inputs
for recording via an external mic preamp
such as an Audient ASP800TM. When using
88.2kHz and 96kHz as a sample rate, you
only have access to 4 channels of digital
input (due to the way SMUX works).

You can use these outputs for more than
just speakers. A good example of this is if
you want to use a dedicated headphone
amplifier for multiple musicians, you can
send out two mono, or one stereo from
these outputs, This is configured in the iD
mixer software.

This can be used instead of or alongside
speakers to get an idea how your mix
sounds on headphones, or to provide artist
headphone mix (or even to drive a small set
of loudspeakers from an unbalanced Y-split
cable).
The headphone output can comfortably
drive a wide range of headphone
impedances meaning that you will get great
sounding audio no matter what model of
headphones you have.

For more information about system
clocking please refer to pages 23 onwards.
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HARDWARE FEATURES

HARDWARE FEATURES

Monitor Control
iD14 provides excellent monitor control
functionality using the large aluminium
encoder and the encoder buttons.
As such, it is possible to control main
loudspeaker and headphone volumes with a
perfectly matched stereo volume control
on the main unit.
The three encoder mode buttons allow you
to change what the encoder controls. The
button that is selected will be illuminated.

iD Button

Hardware Metering

Kensington Lock

The 8-segment hardware meters indicate
playback level of the iD mixer app, so it is
suggested that end users observe their
DAW metering for input levels.

For those who work in educational
establishments or in situations where your
equipment is public facing and subject
to possible theft opportunities, we have
provideda Kensington lock hole to enable
you to protect your iD14.

The iD button provides extra functionality
in the form of an assignable function
button, or it can be used to activate iD14’s
ScrollControl which turns the encoder into
a virtual scroll wheel allowing you to control
elements of your DAW (see page 22)
When the iD button is set as a function
button, the encoder will continue to control
the output that was previously selected. The
iD button is assigned in the iD app.

Status LED
The status LED indicates connection via
USB to your computer. A solidly lit light
means that there is stable communication
between iD14 and your computer.

Loudspeaker and Headphone Buttons
Pressing the speaker or headphone button
allows the encoder to control the level of
the selected output. The volume of the
output is displayed on the meter LEDs and a
press of the encoder will mute the output.
When a selected output is muted, the
encoder button will flash, that encoder
buttons.

15
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SOFTWARE FEATURES

SOFTWARE FEATURES
Input Channels - Channel Types

ID MIXER APP

The iD mixer application features three
types of input channels, these are colour
coded and are as follows:

DAW inputs are provided as two stereo
pairs and are designed as ‘virtual’ playback
channels from your DAW.

•
•
•

Setting outputs in your DAW will feed
signals into these channels. For example if
you send signal to ‘Output 1-2’ in your DAW,
it will be seen in the meters of ‘DAW 1+2’
in the iD mixer. Then if you want to hear it,
turn up the channel’s Main Mix Fader

Analogue Inputs (Mic/Line 1-2) - BLUE
Digital Inputs (S/PDIF or ADAT) - GREEN
DAW Mixes (Playback 1-4) - PURPLE

Channel Naming Strip
The iD mixer application allows you to label
your channels via the editable
marker pen text on console tape!
Double clicking on the channel name
allows you to rename it using up to eight
characters.

Analogue input channels are taken
from the microphone, line or D.I. (channel
one) inputs.
Digital inputs are provided as two
channels in S/PDIF mode and eight
channels in ADAT mode (four at > 48kHz).
You could name it ‘Kick’ for example
17
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SOFTWARE FEATURES
Channel Strip Controls
Gain Boost
Supplies a +10dB gain
boost for low level signals
Polarity Invert
Flips polarity of that
channel.
Cue Send Controls
Level (0 dB to off)
Pan (if using stereo cue)
Alt + click to zero

SOFTWARE FEATURES
Stereo Linking

Master Section

All channels can be linked or unlinked for
stereo or mono operation. Level controls
are combined in stereo operation but stereo pan control remains individual for left
and right channels.

Cmd + click on Mac or
Ctrl + click on Windows
on a solo switch, while on an
un-solo’d channel will
override any previously
solo’d channel
Cmd + click on Mac or
Ctrl + click on Windows
on an already activated
solo switch will clear all
solo’d channels
Main Mix Fader
+6dB to off
Alt + click to zero
Channel Meter
66dB Range
Separate Peak Hold Indicator
Click on peak indicator to clear
Alt + click to clear all

Channel Tape Label
Editable with up to 8
characters

These meters indicate the
output levels of the Main Mix
bus within iD14. They are
mirrored by the 8-segment
hardware LED meters on the
main unit

Alt + click to zero
Cue Master Solo
Use this cue solo
to audition artist mixes
quickly.

1dB steps from 0 to-6dBFS
2dB steps from -8 to -56dBFS

Parameter Info Box
Normally displays main
channel pan value but
if you hover the mouse
over any control - it will
display that parameter’s
value
Channel Solo & Cut
Latching operation

Main Meters
66 dB Range

Cue Master
Level (0 dB to off)
Controls output level
of the summed cue sends

Separate Peak Hold Indicator
Click on peak indicator to clear
Alt + click peak to clear

•
•
•

Unlinked
Individual Level
Individual Pan

•
•
•

Linked
Combined Level
Individual Pan

Useful Functionality

System Panel Button
Opens the iD14 set-up and
routing panel
(see page 23)

Encoder Mode Icons
Icons display the mute states
of the outputs (See page 21)

Main Volume Control
Control the main output
volume in software by
draggingwith your mouse

Every active control
(buttons, pots or
faders) in the iD mixer
application feature
colour coded mouse
over indicators to help
you quickly navigate
and make adjustments.

Mono Sum Button
Monitor the output
of the iD14 DSP mixer
summed to mono

Polarity Reverse Button
Invert polarity of one side
of the stereo monitor output
for stereo difference checks.
This button automatically
activates mono as well.

All controls are also
scrollwheel enabled in
the iD mixer application.
19

Channel View Buttons
Customise your mixer
layout by including only the
channels you are using
Mac Shortcuts:
cmd + 1 Mic/Line
cmd + 2 Optical
cmd + 3 Daw Mixes
Windows Shortcuts:
ctrl + 1 Mic/Line
ctrl + 2 Optical
ctrl + 3 Daw Mixes
iD Mode
Right click to select what
the iD button controls
(See page 22)

Headphone Level Knob
Control the headphone
output volume in software
by dragging with your
mouse
Talkback Button
Operating the talkback
switch routes whichever
input has been selected as
talkback (in system panel)
to the cue and to your
DAW.

20

SOFTWARE FEATURES

SOFTWARE FEATURES

Channel View Settings

Volume Control

Programming the iD Button

When tracking (without using a digitally
expanded iD14) it is most likely that the
following channel view (Analogue + DAW)
would be the most useful, enabling you to
see mic/line inputs and DAW returns:

The Main Mix of the iD mixer is sent to
the outputs which are set-up as Main
Mix in the Routing Matrix (see page 24).
This is your monitor destination and
should be connected to your main studio
loudspeakers. This means that you need to
turn the main mix fader up on any channel
that you want to hear (for speaker output
this is typcially just DAW 1+2).

The iD button can be programmed to
perform different functions (see below). This
can be set by clicking on the iD icon in the
master section of the iD App and selecting
the function from the list of choices.

			
For simple monitoring /
listening or in the box
mixing it may be cleaner
to view just the master
section. When fully
expanded via ADAT with
a device like an ASP800,
you can view all channels
(after 10 mono slots, a
scroll bar appears).

To control the volume of an output, select
the output using the correct encoder mode
button then use the encoder (left image), or
use the coresponding knob in the master
section of the software (right image).

To mute an output, press the encoder
quickly. If you only want it to mute
momentarily then hold it down, and when
it is released it will unmute the audio. In
software, press the output icon to mute it.
When an output is muted the encoder
button on the unit will flash, and in software
the icon will be white.
21

ScrollControl
This allows the encoder to be used as a
scrollwheel for the computer. This allows
you to control plugin parameters and
anything else that is scrollable. This works
well for adding automation or setting
parameters in a hands on way.
To use ScrollControl, hover your mouse
over whatever you want to control and
rotate the encoder.

Mono
A useful feature to check mono
compatibility of mixes (important for DAB
radio and laptop/tablet users)
Mono + Polarity
This will cancel the centre (sum) of
the stereo signal and leave behind the
difference signal (L-R). Monitoring this
provides a great way to listen to stereo
content such as reverbs and also pick up
tricks from your favourite mix engineers.
It is a very useful and different perspective
of the mix balance.
Dim
Provides a -15dB Dim which is useful if you
want to quickly turn down the level to your
speakers without changing the encoder and
losing your monitoring level.
Talkback
Use the iD button to toggle talkback. See
page 25 for information on setting up and
using Talkback.

ScrollControl may act slightly different on
different plugins or DAWs depending on
how they have been programmed to work
with scrolling. If you find it is too sensitive
or not sensitive enough, you can try adjust
your computer scrolling speed.
22

SOFTWARE FEATURES

SOFTWARE FEATURES

System Panel

Output Routing

The system panel is where all the settings
of iD14 are configured. Here you can set
the digital input settings, talkback channel
assignement, mono mode, and output
routing. It also allows you to save and load
mixer presets which is useful if you have
multiple configurations for the mixer.
To open the system panel, press the
SYSTEM button found in the master
section or use Command + 4 in
OSX, or Ctrl + 4 in Windows.

Digital Input Format
Select 8-ch ADAT or 2-ch
S/PDIF input modes for
the optical input here.
ADAT 8-ch 44.1 - 48kHz,
4-ch 88.2kHz - 96kHz.
S/PDIF 2-ch all rates

The output routing matrix lets you patch the
iD Mixer outputs to the physical outputs on
iD14.

Clock Source
Select internal or optical input
as the clock source. Ensure
all sample rates match your
DAW session and computer
settings
Clock Source Status LED
Indicates whether a valid
clock source is present on the
optical input

This is useful if you want to do headphone
mixes in the box rather than using the cue
mixes or using an output as a hardware
send for example.

Talkback Assign
Select any available iD14
input (analogue or digital) to
be the source for talkback
and routed to cues. Mixer
channel becomes talkback
with no feedback possibility

Clocking
If optically expanding iD14, you need to
make sure it syncs with that device. The
external device must be the master, so set
the sample rate you want on that device,
then set the iD14 preferred clock source to
Optical. Look at the Clock source Status LED
for the status of this connection.

Daw Mix
This bypasses the iD14 monitor section
hardwiring the signal from DAW to output.
This stops the encoder from changing the
volume of the audio and is the equivalent of
having the volume set to full (so be careful
when changing the speaker output to Daw
Mix as it could be very loud!).

There are three sources that you can select
for the physical outputs:

Mono Mode
Set whether sum-to-mono
creates a mono sum in one
loudspeaker (one acoustic
source) or creates a ‘phantom
centre’ sum (two acoustic
sources) - they sound different

Main Mix
This is the main output of the iD mixer, so
any channel in the mixer that is turned up
and unmuted with signal will be present in
the Main Mix. This is typically what is used
for the speaker output.

Routing Matrix
Select what is sent to either
the main output or the
headphone output.

Cue Mix
The cue sends on each channel are
summed to the Cue Master found in the
Master Section, the output of which is the
Cue Mix. This is commonly used to create
headphone mixes.

Save and Load
Save and load your own mixer
configurations

Red - No external device or no clock signal detected
Amber - Detected but sample rates do not match.
Green - Valid clock source - iD14 will lock

23

WARNING!
When setting Cue or Daw Mix, be wary of
the levels that are going into the speakers.
Make sure to turn down the audio source
(or Cue master when using the Cues)
BEFORE selecting Cue/Daw mix and then
turn it up to taste.
Example Setups
For more detailed explainations of setting
up iD14, please visit the iD14 support page
at:

www.audient.com/support

24

SOFTWARE FEATURES

SOFTWARE FEATURES

Assigning Talkback

Gooseneck Microphone Use

Saving & Loading Mixer Presets

When a channel is assigned as talkback
source in the iD mixer application system
panel, the selected mixer channel strip
updates to become a talkback channel.

If recording a vocalist or
drummer (with digital
expansion) one microphone
channel on the
iD14 provides
the perfect place
to use a gooseneck
talkback microphone. If it is a
condenser gooseneck make sure you have
the 12VDC power plugged in as phantom
power cannot be used on bus power.

Mixer presets can be saved and loaded in
two ways:
•

Using the buttons at the bottom of the
system panel
• Using standard keyboard shortcuts
• Save:
Mac - Cmd + S
		
Windows - Ctrl + S
• Load:
Mac - Cmd+ O
		
Windows - Ctrl + 0

Saving a Mixer Configuration
Talkback Channel Strip

Channels will be presented in the talkback
assign menu as per their labelling in the
mixer scribble strip (console tape). As such
they are easy to identify.
For many who record vocalists, one input
for the artist will be enough so we suggest
using a talkback microphone in Input 2,
however any of the digital inputs can also be
used.

You are able to save mixer configurations
as a preset for easy access. Your preset
can be named by double clicking in the box.

When an assigned channel
converts to talkback operation,
the cue send level and pan
remain, allowing you to route
the talkback signal to artists via
the cue mix. A routing box
shows which active channel is
set as talkback.
A secondary talkback button
is located on the talkback
channel which can be used
to trigger talkback whilst
setting up the software mixer.
You can also assign the
talkback switch to the iD button
in the master section.

By using the Save to File
button you can save
preset files to any
folder you desire - allowing you to contain
them within your DAW session folder for
example (making recall easier).

Loading a Mixer Configuration
Loading a preset is very simple, just click
on the load button in the System Panel and
select one of your previously named files,
double clicking will also load a preset. To
rename a preset, click to highlight and then
after a pause, click again to rename. To
delete, click to highlight and then click on
the X (delete) button at the bottom.

For information on where preset files are
automatically saved, please visit our help
desk.
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KEYBOARD SHORTCUTS

PROTOOLS SETUP

Keyboard Shortcut Index

Operation with Pro Tools

To allow you to find all shortcuts for the
mixer application in one place without
having to go through each page of this
manual please refer to this table:

Once iD14 has been successfully installed
following the steps detailed after page 6 of
this manual, launch Pro Tools and ensure
that a new session is created at the desired
sample rate (if clocking internally) or at
the rate of the clock source (if clocking
externally).

Location		Mac			Windows		Description
		
Faders		
Alt + Click		
Alt + Click		
Resets fader to unity gain (0 dB)
Pans			
Alt + Click		
Alt + Click		
Resets pan pots to central
									position
Solos			
Cmd + Click		
Ctrl + Click		
Clears all solos if clicking on a solo’d
									channel
									Overrides all other solos (for solo
									exclusive) if clicking on an unsolo’d
									channel
Meters		
Alt + Click		
Alt + Click		
Clicking on peak hold indicator will
									clear all clip indicators
System Panel
Cmd + S		
Ctrl + S		
Save mixer configuration
			Cmd + O		
Ctrl + 0		
Load mixer configuration
View Modes		
Cmd + 1		
Ctrl + 1		
View Mic/Line Inputs
			Cmd + 2		
Ctrl + 2		
View Optical (Digital) Inputs
			Cmd + 3		
Ctrl + 3		
View DAW Mix Inputs
			Cmd + 4		
Ctrl + 4		
View System Panel

If using Windows, make sure that you have
set the correct latency and buffer size
settings in the iD app before opening a
project. Changing these settings will result
in ProTools needing to restart.

I/O Setup
Go to Setup > I/O... to label your inputs and
outputs and ensure that iD14 is correctly
reporting 10-inputs and 4-outputs to and
from Pro Tools. Note that analogue outputs
1-4 are the DAW playback channels in the
iD mixer and can either be routed through
the iD mixer or hard-wired directly from Pro
Tools to the physical outputs.

Playback Engine
Go to Setup > Playback Engine... and ensure
that iD14 is set as the active playback
device.

Please check the iD14 page online at www.audient.com/products/iD14
for the latest mixer application updates.
More shortcuts may be added without notification.

For more Pro Tools information consult
your Avid user manuals & documentation.
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LOGIC PRO SETUP

LOGIC PRO SETUP

Operation with Logic Pro

Operation with Logic Pro

Once iD14 has been successfully installed
following the steps detailed after page 6 of
this manual, launch Logic Pro and check the
following:
Logic Pro > Preferences > Audio

If you are using the iD mixer to monitor
input signals while recording, be sure to
disable Logic’s software monitoring to avoid
phasing as the same source will be heard
twice with a short delay between the low
latency DSP signal and the delayed software
monitoring signal.

If you are using an external clock source
(ADAT or S/PDIF) to clock iD14, please
ensure that your Logic Pro project is set to
the same sample rate when recording and
playingback in a session, otherwise things
may sound a bit sharp or flat!
File > Project Settings > Audio

Assigning I/O
All of iD14’s input and output channels will
be available to Logic for routing. There are
a total of 10-inputs and 4-outputs
reported from the driver.
Ensure that iD14 is selected as the active
audio device and set the buffer size
(to affect system latency). If you are
experiencing issues with playback stability
and CPU loading, try increasing the buffer
size. This appears with “overload” errors
and/or pops and clicks and distortion in the
audio.

You can rename input
and output channels to
whatever you wish using
the I/O label function.
This is a great way to
keep things organised.

If you are using the internal clock in iD14,
setting the sample rate via Logic Pro will
update the iD14 sample rate to follow your
session.

Mix > I/O Labels

There may be a slight pause as the system
re-clocks. This is normal.
This can be verified in Audio MIDI Setup.

For more Logic Pro information please
consult your Apple user manuals &
documentation.

Macintosh HD > Applications > Utilities
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CUBASE/NUENDO SETUP

CUBASE/NUENDO SETUP

Operation with Cubase / Nuendo

Operation with Cubase / Nuendo

Once iD14 has been successfully installed
following the steps detailed after page 6 of
this manual, launch Cubase or Nuendo and
head straight for the Devices menu:

Buffer sizes can be set in the control panel
within the VST devices display. It is ideal
to keep them quite high to reduce CPU
loading if you use the iD mixer as the input
monitoring device while recording.

Devices > Device Setup...
Select Audient iD14 in the menu to ensure
that Cubase / Nuendo addresses the iD14
device driver. You will be asked if this is OK,
select ‘switch’.

Select Audient iD14 in the devices menu...

Select VST Audio System in the devices
menu.

Here you will see the
main iD14 information,
where clock sources
can be set as well as
activating i/o ports.
Be sure to click
Externally Clocked if
clocking from another
digital device via ADAT or SPDIF.

Here you can ensure that all buses have
been created in Cubase / Nuendo and
therefore all ports are addressable in your
session. Add new buses and assign them
to the necessary i/o if required.
I/O ports can be renamed in the device
panel such that they better represent
what you connect to them (for example
Main Monitors, Headphones). This is useful
as any names chosen here will be those
displayed when assigning i/o on track
input/output channel routing.

Close the VST device setup panel and
navigate to the VST connections panel:
Devices > VST Connections (F4)
31

Bus types can be set (mono / stereo) and
the VST control room section can also be
used. For more information regarding setup please consult your Steinberg user
manuals and documentation.
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ABLETON LIVE SETUP

TROUBLESHOOTING & FAQ

Operation with Ableton Live

Troubleshooting

Once iD14 has been successfully installed
following the steps detailed after page 6 of
this manual, launch Ableton Live and head
straight to:
Live > Preferences

In the Live Audio Preference panel you can
set an appropriate buffer size (this can be
kept high if you are monitoring input signals
for recording via the iD mixer. Ensure that
iD14 reports as a 10-in, 4-out device to
Live.
If necessary you can limit the number of
i/o channels reported as active inputs
(from the driver) in Live by using the input
and output config tabs. This is an excellent
feature to help reduce CPU loading if all
channels are not required.

Here navigate to the Audio tab and make
sure that iD14 is assigned as the playback
device.

			
			
			
For more information 		
			
about setting up audio
			
i/o refer to your Ableton
			
Live user manuals &
			documentation.

•

“The unit will not power on”

Double check that the USB cable is plugged
in (and/or 12VDC power adapter). If it still
won’t power on, try using a different USB
port on the computer and possibly even a
different USB cable. If you are using a USB
hub, please try plugging iD14 directly into
the computer.
•

“I get clicks and pops on DAW playback”

This is most likely to do with setting the
buffer size too low for your computer.
This can be caused by running very large
projects with a lot of plugins and virtual
instruments. Experiment with higher buffer
sizes (and Latency settings in Windows).
Typically you want small buffer sizes for
tracking or recording software synths to
keep the latency low. However when mixing
it is fine to set a slightly higher buffer size as
latency is not so much of a problem.
•

Double check that iD14 is set as the active
playback device in your DAW and computer:
System Preferences > Sound > Output Tab
> Audient iD14 (OSX)
Control Panel > Hardware and Sound >
Sound > Manage Audio Devices > Audient
iD14 (Windows)
Launch the iD mixer application to
activate communication between your
computer and iD14. This only needs to be
done once straight after power up. Once
iD14 is set to the operational state you
desire, you can quit the iD application and it
will continue to function as intended.
In the software mixer, locate the DAW
channels by pressing the DAW view button
and increase the level of DAW 1+2 fader.

“When I connect to my computer,
I cannot play any audio out from iD14”

Firstly double check that the USB cable
connecting iD14 to your computer is
functional and attached at both ends.
33
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TROUBLESHOOTING & FAQ

TROUBLESHOOTING & FAQ

Troubleshooting

Troubleshooting

FAQs

•

For more information and bug support,
please search our online Help Centre which
can be found here:

•

“I have clocking issues which include
iD14 not locking to external ADAT
or SPDIF devices or operating at the
incorrect rate compared to my session”

If there is an issue with syncing of an
external device, the Status LED in the
System Panel will be red or yellow. If the
status light is red then iD14 cannot detect
a clock signal from an external device, and
yellow if it can detect a signal at the wrong
sample rate.
To change sample rate in OSX go to Audio
MIDI Setup found by navigating to the folder:
Macintosh HD > Applications > Utilities >
Audio MIDI Setup
Ensure that Audient iD14 is seen as an
audio device (Window Menu > Show Audio
Window).

Double check that an appropriate clock
source is selected (Internal for master
operation), ADAT or S/PDIF clock for
external slave operation. Ensure that you
see the correct sample rate displayed in
the Format drop-down menu.

“How do I reset the iD mixer application
to it’s default state?”

To reset the mixer application, quit the
iD app completely, then navigate to the
following folder and delete the state.xml file
(it will replenish upon a fresh launch of the
application)
Macintosh HD > User > Library > Application
Support > Audient > iD > state.xml
(C:) > Users > yourusername > AppData >
Roaming > Audient > iD > state.xml

If you are using Windows, go to the iD icon
in the system tray and right click on it. This
will bring up some settings including sample
rate. Alternatively you can alter these
setting in the Setup tab of the iD app.
Change the sample rate to match that of
the external ADAT device and session.

www.audient.com/support

For technical support please create
a ticket in our online support system,
Zendesk which can also be found in the
support section of our website
(see link above).

Do not delete the parent folder as this will
also contain your iD mixer presets.
•

“How do I make sure I have the latest
version of iD firmware/software?”

To check for the latest updates to the
iD desktop mixer application please visit:
www.audient.com/products/iD14
download the package and install.
You will be made aware of firmware
releases from the iD app when connected
to the internet. Please refer to page 10 in
this user manual for more information
regarding firmware update.
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SPECIFICATIONS

DIMENSIONS
MICROPHONE PREAMPLIFIER:

173mm

(measurement includes ADC signal path)

D.I / INSTRUMENT INPUT:
D.I GAIN: 			
MAXIMUM INPUT LEVEL:
INPUT IMPEDANCE: 		
FREQUENCY RESPONSE:
THD+N @ 0dBu (1kHz):
SNR: 			
1/4” TS JACK:		

0 to 66dB (incl. +10dB software boost)
+9 dBu (0.6% THD typical)
>500k Ω unbalanced
±0.1dB 20Hz to 22kHz
<0.04% all musical 2nd and 3rd harmonic
95 dB un-weighted, 98 dB A-weighted
Tip (Hot) & Sleeve (Shield)

0 to 66 dB (incl. +10 dB software boost)
-10 to 56 dB (-10dB hardwired line pad)
48V ±4V @ 10mA channel (12VDC only)
<-127.0 dBu
>80 dB @ 1kHz
+12 dBu (0 dBFS digital maximum)
2.8k Ω balanced
>8k Ω balanced
±0.1 dB 20Hz to 22kHz @ min. gain
±1.0 dB 20Hz to 22kHz @ max. gain
<-90 dBu
<0.0025% (-92 dBu)
96 dB un-weighted, 99 dB A-weighted
Pin 2 (Hot), Pin 3 (Cold) & Pin 1 (Shield)
Tip (Hot), Ring (Cold) & Sleeve (Shield)

120mm

(Channel 1)

MIC GAIN:			
LINE GAIN:			
PHANTOM POWER: 		
MIC EIN: 			
CMRR: 			
MAXIMUM INPUT LEVEL:
INPUT IMPEDANCE (Mic):
INPUT IMPEDANCE (Line):
FREQUENCY RESPONSE:
			
CROSSTALK: 		
THD+N @ 0dBu (1kHz):
SNR: 			
XLR COMBI FEMALE: 		
1/4” TRS JACK:		

HEADPHONE OUTPUT / DAC 3 & 4:
(Measured under AES-17 at phones output)

ANALOGUE TO DIGITAL CONVERTER (ADC 1 & 2):
(Measured sans microphone preamplifier under AES-17)
MAXIMUM INPUT LEVEL:
DIGITAL REFERENCE LEVEL:
FREQUENCY RESPONSE:
CROSSTALK:		
THD+N @ -1dBFS (1kHz):
THD+N @ -6dBFS (1kHz):
DYNAMIC RANGE:		

+12 dBu (0 dBFS digital maximum)
+12 dBu = 0 dBFS
±0.1 dB 10Hz to Fs/2 (flat to nyquist)
-100 dBu @ 1kHz & 10kHz
<0.002% (-94 dB)
<0.0015% (-96.5 dB)
113 dB un-weighted, 116 dB A-weighted

MAXIMUM OUTPUT LEVEL:
DIGITAL REFERENCE LEVEL:
OUTPUT IMPEDANCE:
VOLTAGE GAIN: 		
FREQUENCY RESPONSE:
CROSSTALK:		
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE:		
MAXIMUM LEVEL into 30 Ω:
MAXIMUM LEVEL into 60 Ω:
MAXIMUM LEVEL into 600 Ω:
1/4” TRS JACK:		

+12 dBu (0 dBFS digital maximum)
+12 dBu = 0 dBFS
<30 Ω unbalanced
+6 dB (optimised for loudness)
±1.0dB 10Hz to Fs/2 (load dependent)
<-100 dBu @ 1kHz & 10kHz
<0.002% (-94 dB)
108 dB un-weighted, 111 dB A-weighted
+4 dBu 0.005% THD+N Power: 101mW
+5 dBu 0.004% THD+N Power: 64mW
+13 dBu 0.0025% THD+N Power: 39mW
Tip (Left), Ring (Right) & Sleeve (Shield)

173mm

40.7mm

DIGITAL TO ANALOGUE CONVERTER (DAC 1 & 2):
(Measured under AES-17 at line outputs 1 & 2)

POWER SUPPLY:
12VDC Centre Positive - 1.25A (required for full 48V Phantom
Power
iD14 requires a lot of power for class leading converters and
class-A microphone preamplfiers. We could not beat the laws of
physics so anexternal supply is required for 48V phantom power.
Your microphones will thank you when they get enough voltage!

8-CHANNEL ADAT:		
4-CHANNEL ADAT:		
STEREO S/PDIF / TOSLINK:

44.1kHz to 48.0kHz
88.2kHz to 96.0kHz SMUX
44.1kHz to 96.0kHz (Stereo)

USB2.0 HIGH SPEED:
BUS POWER: 		
			
			

500mA @ 5V System Limit
425mA @ 5V Maximum (No 48V)
(Phantom power only available on 12VDC)

No. of INPUT CHANNELS:
No. of OUTPUT CHANNELS:

10
4

NEUTRIK

NEUTRIK

61.1mm

+12 dBu (0 dBFS digital maximum)
+12 dBu = 0 dBFS
<100 Ω
±0.1 dB 10Hz to Fs/2 (flat to nyquist)
<-105 dBu @ 1kHz & 10kHz
<0.003% (-90.5 dB)
114 dB un-weighted, 117 dB A-weighted
Tip (Hot), Ring (Cold) & Sleeve (Shield)

62.1mm

MAXIMUM OUTPUT LEVEL:
DIGITAL REFERENCE LEVEL:
OUTPUT IMPEDANCE:
FREQUENCY RESPONSE:
CROSSTALK:		
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE:		
1/4” TRS JACK:		

DIGITAL INPUT:

(2 Analogue, 8 Digital)
(4 Analogue)

DSP MIXER LATENCY:
ROUND TRIP (in-to-out)
			44.1kHz 1.660ms
			48.0kHz 1.531ms
			88.2kHz 0.844ms
			96.0kHz 0.771ms
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WARRANTY

SERVICE

Warranty Statement

Service Information

Your iD14 comes with a manufacturer’s warranty for one year (12 months) from the
date of despatch to the end user.

iD14 contains no user-serviceable components, please refer to qualified service personnel
for diagnosis and repair. Your warranty will be void if you tamper with the device at component
level. If you have any questions with regard to the repair, please contact Audient Ltd.

The warranty covers faults due to defective materials used in manufacture and faulty
workmanship only.
During the warranty period Audient will repair at its discretion or replace the faulty unit
provided it is returned carriage paid to an authorised Audient service centre. We will not
provide warranty repair if in our opinion the fault has resulted from unauthorised modification,
misuse, negligence or accident.
We accept liability to repair or replace your iD14 as described above. We do not accept
any additional liability. This warranty does not affect any legal rights you may have against
the person who supplied this product - it is additional to those rights.

If your unit is in warranty, please contact your dealer directly for a repair or replacement (at
the discretion of the dealer).
For out of warranty repairs, please contact Audient Ltd, after which a Return Materials
Authorization (RMA) number will be assigned. This number will serve as a reference for you
and helps facilitate and expedite the return process. When the unit is returned please include
this RMA number along with a description of the fault inside the packaging box.
To request an RMA, access technical support & FAQs, ask for troubleshooting assistance or
make an enquiry, please visit: www.audient.com/support

Warranty Limitations
This warranty does not cover damage resulting from accident or misuse. The warranty is void
unless repairs are carried out by an authorised service centre. The warranty is void if the unit
has been modified other than at the manufacturer’s instruction. The warranty does not cover
components which have a limited life, and which are expected to be periodically replaced for
optimal performance. We do not warrant that the unit shall operate in any other way than as
described in this manual.

Audient Ltd
Aspect House
Herriard
Hampshire
RG25 2PN
United Kingdom

Tel: 0044 1256 381944
www.audient.com
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GLOSSARY

A		
ADAT		
ADC		
DAW		
ASP		
CPU		
CUE		
DAC		
dB		
dBu		
dBFS		
DC		
D.I		
DoC		
DSP		
EQ		
FAQ		
FCC		
GB		
GUI		
HPF		
HV		
i/o		
JFET		
LED		
RoHS		
RAM		
S/PDIF
THD+N
TRS		
TS		
USB		
V		
XLR		
		

Amperes
Alesis Digital Audio Tape
Analogue to Digital Converter
Digital Audio Workstation
Analogue Signal Processing
Central Processing Unit
Artist Headphone Mix
Digital to Analogue Converter
Decibel
Decibel referenced to 0.775Vrms = 0 dBu
Decibel Full Scale
Direct Current
Direct Injection (Instrument Input)
Declaration of Conformity
Digital Signal Processing
Equaliser
Frequently Asked Questions
Federal Communications Commission
Gigabyte
Graphical User Interface
High Pass Filter
High Voltage
Input / Output
Junction Field Effect Transistor
Light Emitting Diode
Restriction of Hazardous Substances
Random Access Memory
Sony Philips Digital Interface Format
Total Harmonic Distortion + Noise
Tip Ring Sleeve (1/4” Jack Balanced)
Tip Sleeve (1/4” Jack Unbalanced)
Universal Serial Bus
Volts
Extra Live Return, Extremely Low Resistance,
Canon X Series, Latching, Resilient Rubber Compound... or make up your own!
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